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Introduction & Overview 
 
Welcome to the AHCA PDPM Grouper Tool User Guide! The AHCA Grouper Tool 
(“Tool”) was developed to help AHCA members with PDPM implementation and to 
directionally understand the financial impact of PDPM. The user guide explains how to 
use the grouper tool, along with important model and data considerations. 
 
The tool allows the user to input patient-level data and derive estimated PDPM 
payments for non-interrupted patient stays. The user will be able to use this tool to 
understand the difference between reimbursement under RUG-IV and PDPM at a 
patient and facility level. The Tool has 6 tabs which include instructions, as necessary. 
 
If you have any questions, please contact PDPM@ahca.org. As a reminder, AHCA 
replies to inquiries on a biweekly basis.   
 
Grouper Tool Tabs 

 
1. Introduction: This tab provides a high-level overview of the model including a 

table of contents.   
 

2. Data Input: All unique patient level data is input here. The data is a combination 
of non-medical patient and facility descriptive data as well as Minimum Data Set 
(MDS) resident assessment and care screening information.   

 
3. Payment Analysis: The patient PDPM calculation is run through an embedded 

Macro in the Excel document and patient-level results are summarized on this 
tab. The “Patient Analysis” and “Facility Analysis” tabs both reference this tab for 
analysis.  

 
4. Patient Analysis: This tab details an individual patient’s PDPM case mix 

classification and the per diem reimbursement. This tab also compares 
reimbursement under RUG-IV and PDPM.  

 
5. Facility Analysis: This tab details all patients for a single facility, comparing 

reimbursement under RUG-IV and PDPM.   
 

6. ICD-10 Code List: This provides the user with an ICD-10 code reference list.  
 

 
Note: The Tool’s calculation of the nursing component is based on the RUG-IV 
calculation due to the similarities between RUG-IV and PDPM.   
 

mailto:PDPM@ahca.org
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Data Input 
The Data Input tab allows the user to input patient-level data for analysis and is set up 
to analyze the impact of multiple patients at once. The cells highlighted in yellow are for 
user input. The grey cells are automatically populated based on the input data and will 
be used throughout the Tool.  

Note: The functionality of the model is dependent on its current structure. The 
user is encouraged to input data into the yellow highlighted cells only. Adding or 
deleting cells outside of the yellow highlighted areas could result in the model 
malfunctioning. For the user’s benefit the ability to edit or delete non-yellow cells 
has been restricted.  

Step 1: Prepare the data for entry by gathering the necessary data on individual 
patients. The Tool has the capacity to analyze multiple patients at once, so please work 
with your IT team on how to best capture the relevant information.   

Note: Please reference the Appendix: Data Input Glossary for column 
descriptions and data input requirements such as the use of “6” versus “06” in 
certain fields.  

Step 2: Input patient level data into the highlighted yellow cells. Users may copy/paste a 
spreadsheet with multiple patients.  

 
Step 3: Complete a Primary Diagnosis Code check. Certain ICD-10 codes are insufficient 
to be considered a Primary Diagnosis. If an entered Primary Diagnosis Code (Column 
“CX”) is insufficient, it will be flagged as “Return to Provider” and the user will be required 
to provide another primary diagnosis code. The user is encouraged to reference the ICD-
10 Code List tab (Tab 6) to identify acceptable ICD-10 primary diagnosis codes.  
 

Note: If the I8000A 
(Primary Diagnosis Code) 
is blank, the patient will 
receive a $0 PDPM 
payment for the stay.  
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Running the Model 
 
The PDPM payment is calculated through an Excel-based Macro. Running the model 
involves a Macro preparation step.  
 
Step 1: Click the "Developer" tab at the top of the page and select Macros on the left. If 
you don't have the Developer tab, click on the File menu and then select Options. When 
Excel Options window appears, click on the Customize Ribbon option. Click Developer 
checkbox under the list of main tabs on the right. Then click the OK button.  

Step 2: Highlight the "Macro2" line from the options 
available and select "Edit". (See Right) 

 

Step 3: Update the "fRow=47" to the number of lines in 
in the Data Input tab. 47 is only the default position and 
is intended to be updated. For example, if your input 
data populates through line 76 then you update it to 
"fRow=76". (See Below) 
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Step 4: Click the Save button in the Macro 
 

 
Step 5: Now that 
the Macro is set to 
run, the user can 
move over to the 
Payment Analysis 
tab to run the 
Macro. Click on 
the “Run Macro” 
button at the top 
of the page to run 
the PDPM 
calculation 
 
 
 
Note: The amount of data on the Data Input tab determines how long the Macro 
takes to run. It typically takes about 7-10 minutes for a data set of 150 patients 
(e.g. lines of data for 150 patients).  
 
Note: Every time you wish to refresh a data set, the results of the calculation in 
the “Payment Analysis” tab need to be cleared by deleting Row 22 and below. For 
the benefit of the user, Rows 1-21 have been locked and can’t be edited or deleted 
accidentally. 
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Patient Analysis 
The Patient Analysis Tab provides a detailed look at reimbursement for an individual 
patient by component over the duration of an individual patient's stay. 

This tab is driven off the Payment Analysis tab, so the user must have run the Macro in 
order to use this tab.  

 
Step 1: Manually enter a patient ID into the highlighted cell (C15). A dropdown box will 
be available in cell C15 for the user to select from the patient ID’s listed in the Data 
Input tab.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
Note: There is no further manipulation required for the patient analysis tab. The 
user can view the overall comparison between PDPM and RUG-IV for this patient, 
as well as the PDPM reimbursement by components by day.  
 
Note: The user is encouraged to use the CMS Grouper Tool to perform patient-
level sensitivity analysis to understand the impact of changing individual MDS 
items on reimbursement. The CMS Grouper Tool is available at: 
 
https://www.cms.gov/Medicare/Medicare-Fee-for-Service-Payment/SNFPPS/PDPM.html 
 
  

 

https://www.cms.gov/Medicare/Medicare-Fee-for-Service-Payment/SNFPPS/PDPM.html
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Facility Analysis 
The Facility Analysis tab allows the user to analyze the impact of PDPM at a facility-
level. The user inputs the facility ID into one of the highlighted yellow cells in column B, 
and the remaining information automatically populates. 

Like the Patient Analysis tab, this tab is driven off the Payment Analysis tab, so the user 
must have run the Macro in order to use this tab. 

 

Step 1: Input Facility ID into the yellow highlighted section below.  

 

 

 

 

 
 
 
 
 
 
 

 
 
 
Trick: In order to add in 
multiple facilities quickly, 
select all the Facility ID's in the 
Payment Analysis tab and 
paste them to the right of the 
table. Next hit "Alt + A + M", 
and then hit "OK", this will 
remove duplicates from your 
list. You can then copy/paste 
your list into the highlighted 
yellow fields in order to auto 
populate the table. 
 
 
Note: There is no further manipulation required for the patient analysis tab. The 
user can view the overall comparison between PDPM and RUG-IV for each facility.  
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Appendix: Data Input Glossary 
 

Metric Description  
FacilityID The facility ID allows the user to understand the PDPM impact by facility.  

Facility Description 
The facility name allows the user to understand the PDPM impact by facility 
name 

State State name 

Zip Code 
The zip code where the facility is located. The zip code is used to identify the 
wage index used in the PDPM calculation 

PatientMRN Patient medical record number.  
StayStartDate Stay start date 
StayEndDate Stay end date 
PtDays The total duration of the patient stays in days 
RoomChg  Room Charge 
RoomContract  Room Contract 
RoomChg&Contract  Total Room Charge + Room Contract 
PPD  Room Charge + Room Contract / Patient Days 
AssessmentID Assessment ID 
Z0100A Medicare Part A: MDS Generated HIPPS Code for RUG IV 
Z0150A Medicare Part A Non-Therapy HIPPS Billing Code 

B0100 
Comatose: 0 No and 1 Yes. Documented comatose during the 7 day look 
back.  

B0700 
Makes Self Understood: 0 Understood, 1 usually understood, 2 sometime 
understood, 3 Rarely/never understood 

C0500 
Cognitive summary score 0-15, 99. A "-" input will be converted to "0" in the 
calculation 

C0700 
Short-term Memory OK. Score is either 0 or 1. A "-" will be converted to a "0" 
in the calculation 

C1000 
Cognitive Skills for Daily Decision Making. Score is 0, 1, 2, 3 or 4. A "-" will 
be converted to a "0" in the calculation 

D0300 
Total PHQ-9 Score - Interview Severity Score. Score 0-27, 99. A "-" input will 
be converted to "0" in the calculation 

D0600 
Total PHQ-9 Score - Staff Assessment Severity Score. Score 0-30, 99. A "-" 
input will be converted to "0" in the calculation 

GG0130A1 Eating: Score 01, 02, 03, 04, 05, 06, 07, 09, 10, 88 
GG0130B1 Oral Hygiene: Score 01, 02, 03, 04, 05, 06, 07, 09, 10, 88 
GG0130C1 Toileting Hygiene: Score 01, 02, 03, 04, 05, 06, 07, 09, 10, 88 
GG0170B1 Bed Mobility: Sit to Lying: Score 01, 02, 03, 04, 05, 06, 07, 09, 10, 88 

GG0170C1 
Bed Mobility - Lying to Sitting on Side of Bed: Score 01, 02, 03, 04, 05, 06, 
07, 09, 10, 88 

GG0170D1 Transfer - Sit to Stand: Score 01, 02, 03, 04, 05, 06, 07, 09, 10, 88 
GG0170E1 Transfer - Chair/Bed-to-chair: Score 01, 02, 03, 04, 05, 06, 07, 09, 10, 88 
GG0170F1 Transfer - Toilet Transfer: Score 01, 02, 03, 04, 05, 06, 07, 09, 10, 88 

GG0170J1 
Walking - Walk 50 Feet with Two Turns: Score 01, 02, 03, 04, 05, 06, 07, 09, 
10, 88 

GG0170K1 Walking - Walk 150 Feet: Score 01, 02, 03, 04, 05, 06, 07, 09, 10, 88 

H0100C 
Ostomy (Including Urostomy, Ileostomy, and Colostomy use any time in the 
last 7 days. Score 0 = No and 1= Yes 

H0100D 
Intermittent Catheterization use any time in the last 7 days. Score 0 = No 
and 1= Yes 

H0200C Urinary Toileting Program during the last 7 days. Score 0 = No and 1= Yes 
H0500 Bowel Toileting Program during the last 7 days. Score 0 = No and 1= Yes 
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I1700 Use of Multidrug Organism in the last 7 days. Score 0 = No and 1= Yes 
I2500 Wound Infection Treatment. Score 0 = No and 1= Yes 
I2900 Diabetes Mellitus. Score 0 = No and 1= Yes 
I4300 Aspasia. Score 0 = No and 1= Yes 
I4500 CVA, TIA, or stroke. Score 0 = No and 1= Yes 
I4900 Hemiplegia or Hemiparesis. Score 0 = No and 1= Yes 
I5200 Multiple Sclerosis (MS). Score 0 = No and 1= Yes 
I5500 Traumatic Brain Injury (TBI) Score 0 = No and 1= Yes 

I5600 
Malnutrition (protein or calorie) or at risk for malnutrition. Score 0 = No and 
1= Yes 

I6200 Asthma, COPD, or chronic lung disease. Score 0 = No and 1= Yes 

I8000A 
Additional Active Diagnosis. Note do not include "." in the ICD10 code for this 
input 

I8000B 
Additional Active Diagnosis. Note do not include "." in the ICD10 code for this 
input 

I8000C 
Additional Active Diagnosis. Note do not include "." in the ICD10 code for this 
input 

I8000D 
Additional Active Diagnosis. Note do not include "." in the ICD10 code for this 
input 

I8000E 
Additional Active Diagnosis. Note do not include "." in the ICD10 code for this 
input 

I8000F 
Additional Active Diagnosis. Note do not include "." in the ICD10 code for this 
input 

I8000G 
Additional Active Diagnosis. Note do not include "." in the ICD10 code for this 
input 

I8000H 
Additional Active Diagnosis. Note do not include "." in the ICD10 code for this 
input 

I8000I 
Additional Active Diagnosis. Note do not include "." in the ICD10 code for this 
input 

I8000J 
Additional Active Diagnosis. Note do not include "." in the ICD10 code for this 
input 

K0100A 
Swallowing/Nutritional Status: Loss of liquids/solids from mouth. Score 0 = 
No and 1= Yes 

K0100B 
Swallowing/Nutritional Status: Holding food in mouth/cheeks. Score 0 = No 
and 1= Yes 

K0100C 
Swallowing/Nutritional Status: Coughing or choking when swallowing. Score 
0 = No and 1= Yes 

K0100D 
Swallowing/Nutritional Status: Complaints of difficulty or pain. Score 0 = No 
and 1= Yes 

K0100Z Swallowing/Nutritional Status: None of the above. Score 0 = No and 1= Yes 
K0510A2 Nutritional Approaches: Parenteral/IV feeding. Score 0 = No and 1= Yes 
K0510B2 Nutritional Approaches: Feeding Tube. Score 0 = No and 1= Yes 
K0510C2 Nutritional Approaches: Mechanically Altered Diet. Score 0 = No and 1= Yes 

K0710A2 
Percent Intake by Artificial Route. Proportion of Total Calories. Score 1. 25% 
or less, 2. 26%-50%, 3. 51% or more.  

K0710B2 
Percent Intake by Artificial Route. Proportion of Total Calories. Score 1. 
500cc/day or less, 2. 501cc/day or more 

M0300D2 Current Number of Stage 4 Pressure Ulcers 

M1040A 
Skin Condition Status: Other Ulcers, Wounds and Skin Problems. Infection of 
the Foot. Score 0 = No and 1= Yes 

M1040B 
Skin Condition Status: Other Ulcers, Wounds and Skin Problems. Diabetic 
Foot Ulcers. Score 0 = No and 1= Yes 



 
 

11 

 

M1040C 
Skin Condition Status: Other Ulcers, Wounds and Skin Problems. Other 
Open Lesions on the Foot. Score 0 = No and 1= Yes 

O0100B2 
Special Treatments, Procedures and Programs. Radiation. Score 0 = No and 
1= Yes 

O0100D2 
Special Treatments, Procedures and Programs. Suctioning. Score 0 = No 
and 1= Yes 

O0100E2 
Special Treatments, Procedures and Programs. Tracheostomy Care. Score 
0 = No and 1= Yes 

O0100F2 
Special Treatments, Procedures and Programs. Ventilator or Respirator. 
Score 0 = No and 1= Yes 

O0100H2 
Special Treatments, Procedures and Programs. IV Medications. Score 0 = 
No and 1= Yes 

O0100I2 
Special Treatments, Procedures and Programs. Transfusions. Score 0 = No 
and 1= Yes 

O0100M2 
Special Treatments, Procedures and Programs. Active Disease Infection. 
Score 0 = No and 1= Yes 

O0400A1 
Speech-Language Pathology and Audiology Services. Individual minutes. 
Entered as minutes. 4-digit number.  

O0400A2 
Speech-Language Pathology and Audiology Services. Concurrent minutes. 
Entered as minutes. 4-digit number.  

O0400A3 
Speech-Language Pathology and Audiology Services. Group minutes. 
Entered as minutes. 4-digit number.  

O0400B1 
Occupational Therapy. Individual minutes. Entered as minutes. 4-digit 
number.  

O0400B2 
Occupational Therapy. Concurrent minutes. Entered as minutes. 4-digit 
number.  

O0400B3 Occupational Therapy. Group minutes. Entered as minutes. 4-digit number.  
O0400C1 Physical Therapy. Individual minutes. Entered as minutes. 4-digit number.  
O0400C2 Physical Therapy. Concurrent minutes. Entered as minutes. 4-digit number.  
O0400C3 Physical Therapy. Group minutes. Entered as minutes. 4-digit number.  

O0500A 
Restorative Nursing Programs. Range of Motion Passive. Entered as 
number of days. One day entered as "1".  

O0500B 
Restorative Nursing Programs. Range of Motion Active. Entered as number 
of days. One day entered as "1".  

O0500C 
Restorative Nursing Programs. Splint or Brace Assistance. Entered as 
number of days. One day entered as "1".  

O0500D 
Restorative Nursing Programs. Bed Mobility. Entered as number of days. 
One day entered as "1".  

O0500E 
Restorative Nursing Programs. Transfer. Entered as number of days. One 
day entered as "1".  

O0500G 
Restorative Nursing Programs. Dressing/Grooming. Entered as number of 
days. One day entered as "1".  

O0500H 
Restorative Nursing Programs. Eating / Swallowing. Entered as number of 
days. One day entered as "1".  

O0500I 
Restorative Nursing Programs. Amputation Care. Entered as number of 
days. One day entered as "1".  

O0500J 
Restorative Nursing Programs. Communication. Entered as number of days. 
One day entered as "1".  
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